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rRozDzIAt 1

Wprowadzenie

QGIS Server is an open source WMS, WES, OGC API for Features 1.0 (WFS3) and WCS implementation that, in
addition, implements advanced cartographic features for thematic mapping. QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Nginx). It has
Python plugin support allowing for fast and efficient development and deployment of new features.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is used for
graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS Server uses
cartographic rules as a configuration language, both for the server configuration and for the user-defined cartographic
rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web look
the same as in desktop GIS.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Linux (Debian, Ubuntu
and derivatives) and on Windows. For more information about server plugin development, please read server_plugins.

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free
Documentation License, Version 1.3 or any later version published by the Free Software Foundation; with no Invariant
Sections, no Front-Cover Texts, and no Back-Cover Texts.

A copy of the license is included in the section gnu_fdl.
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Pierwsze kroki

2.1 Installation on Debian-based systems

We will give a short and simple installation how-to for a minimal working configuration on Debian based systems
(including Ubuntu and derivatives). However, many other distributions and OSs provide packages for QGIS Server.

© Informacja

In Ubuntu you can use your regular user, prepending sudo to commands requiring admin permissions. In Debian
you can work as admin (root), without using sudo.

Requirements and steps to add official QGIS repositories to install QGIS Server on a Debian based system are provided
in QGIS installers page. You may want to install at least the latest Long Term Release.

Once the target version repository is configured and QGIS Server installed, you can test the installation with:

[/usr/lib/cgi*bin/qgis_mapserv.fcgi

If you get the following output, the server is correctly installed.

© Informacja

Depending on the version of QGIS, you might see slightly different output reported when you run

gqgis_mapserv. fcgi.

—variable.

—variable.

Content-Type:

QFSFileEngine:
Warning 1: Unable to
Warning 1: Unable to
Warning 1: Unable to

:open:

Warning 1: Unable to
Warning 1: Unable to

Content-Length: 206
text/xml;

No file name specified

find driver
find driver
find driver

find driver
find driver

ECW to
ECW to
JP2ECW

ECW to
JP2ECW

charset=utf-8

unload from GDAL_SKIP environment variable.
unload from GDAL_SKIP environment variable.
to unload from GDAL_SKIP environment.

unload from GDAL_SKIP environment variable.
to unload from GDAL_SKIP environment.

(ciag dalszy na nastgpnej stronie)
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(kontynuacja poprzedniej strony)

<ServiceExceptionReport version="1.3.0" xmlns="https://www.opengis.net/ogc">
<ServiceException code="Service configuration error">Service unknown or.
—unsupported</ServiceException>

</ServiceExceptionReport>

© Informacja

As seen below, QGIS reports a Status 400 code, which correctly identifies the request has failed because there is
no active http session. This is not a bug and indicates the server is functioning properly.

Application path not initialized

Application path not initialized

Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment.
—variable.

"Loading native module /usr/lib/ggis/server/libdummy.so"

"Loading native module /usr/lib/qgis/server/liblandingpage.so"

"Loading native module /usr/lib/gqgis/server/libwcs.so"

"Loading native module /usr/lib/gqgis/server/libwfs.so"

"Loading native module /usr/lib/qgis/server/libwfs3.so"

"Loading native module /usr/lib/qgis/server/libwms.so"

"Loading native module /usr/lib/ggis/server/libwmts.so"

QFSFileEngine::open: No file name specified

Content-Length: 102

Content-Type: application/json

Server: QGIS FCGI server — QGIS version 3.22.6-Bialtowieza

Status: 400

[{"code":"Bad request error","description":"Requested URI does not match any.
—registered API handler"}]

Let’s add a sample project. You can use your own, or one from Training demo data:

mkdir /home/ggis/projects/

cd /home/ggis/projects/

wget https://github.com/qgis/QGIS-Training-Data/archive/release_3.22.zip

unzip release_3.22.zip

mv QGIS-Training-Data-release_3.22/exercise_data/qgis—-server—-tutorial-data/world.
—qgs

mv QGIS-Training-Data-release_3.22/exercise_data/qgis—server—tutorial-data/
—naturalearth.sqglite

Of course, you can use your favorite GIS software to open this file and take a look at the configuration and available
layers.

To properly deploy QGIS server you need a HTTP server. Recommended choices are Apache or NGINX.

6 Rozdziat 2. Pierwsze kroki
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2.1.1 Apache HTTP Server

© Informacja

In the following, please replace qgis . demo with the name or IP address of your server.

1. Install Apache and mod_fcgid:

[apt install apache2 libapache2-mod-fcgid ]

2. You can run QGIS Server on your default website, but let’s configure a virtualhost specifically for this, as
follows.

1. In the /etc/apache2/sites—-available directory, create a file called ggis.demo.conf,
with this content:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
ServerName ggis.demo

DocumentRoot /var/www/html

# Apache logs (different than QGIS Server 1log)
ErrorLog ${APACHE_LOG_DIR}/ggis.demo.error.log
CustomLog ${APACHE_LOG_DIR}/ggis.demo.access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120

FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"

# OGIS log
FcgidInitialEnv QGIS_SERVER_LOG_STDERR 1
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

# default QGIS project
SetEnv QGIS_PROJECT_FILE /home/ggis/projects/world.qgs

# OGIS_AUTH_DB_DIR PATH must lead to a directory writeable by the Server
—'s FCGI process user

FcgidInitialEnv QGIS_AUTH DB_DIR_PATH "/home/qgis/ggisserverdb/"

FcgidInitialEnv QGIS_AUTH_PASSWORD_FILE "/home/ggis/ggisserverdb/qgis—
—auth.db"

# Set pg access via pg_service file
SetEnv PGSERVICEFILE /home/ggis/.pg_service.conf
FcgidInitialEnv PGPASSFILE "/home/qgis/.pgpass"

# 1f ggis—-server is installed from packages in debian based distros this.
—~1is usually /usr/lib/cgi-bin/
# run "locate ggis_mapserv.fcgi" if you don't know where ggis_mapserv.
—~fcgl is
ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin/">
AllowOverride None
Options +ExecCGI -MultiViews -SymLinksIfOwnerMatch
Require all granted
</Directory>

(ciag dalszy na nastgpnej stronie)
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(kontynuacja poprzedniej strony)

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

</VirtualHost>

© Informacja

Some of the above configuration options are explained in the Server environment variables and
pg_service file sections.

2. Let’s now create the directories that will store the QGIS Server logs and the authentication database:

mkdir -p /var/log/qgis/

chown www-data:www-data /var/log/qgis

mkdir -p /home/qgis/ggisserverdb

chown www-data:www—-data /home/ggis/ggisserverdb

© Informacja

www-data is the Apache user on Debian based systems and we need Apache to have access to
those locations or files. The chown www-data. .. commands change the owner of the respective
directories and files to www-data.

3. We can now enable the virtual host and the fcgid mod if it’s not already done:

azenmod fcgid
azenmod rewrite
azensite ggis.demo

4. Now restart Apache for the new configuration to be taken into account:

[systemctl restart apache?2 }

5. Now that Apache knows that he should answer requests to http://qgis.demo we also need to setup the client
system so that it knows who ggis . demo is. We do that by adding 127.0.0.1 ggis.demo in the hosts

file.
# Replace 127.0.0.1 with the IP of your server.
sh -c "echo '127.0.0.1 ggis.demo' >> /etc/hosts"

@ Wazne

Remember that both the ggis.demo.conf and /etc/hosts files should be configured for your setup to
work. You can also test the access to your QGIS Server from other clients on the network (e.g. Windows or macos
machines) by going to their /etc/hosts file and point the ggis.demo name to whatever IP the server
machine has on the network (not 127.0.0.1 as it is the local IP, only accessible from the local machine).
On *nix machines the hosts file is located in /etc, while on Windows it’s under the C:\Windows\
System32\drivers\etc directory. Under Windows you need to start your text editor with administrator
privileges before opening the hosts file.

QGIS Server is now available at http://qgis.demo. To check, type in a browser, as in the simple case:

8 Rozdziat 2. Pierwsze kroki
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http://ggis.demo/cgi-bin/ggis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&
—REQUEST=GetCapabilities

2.1.2 NGINX HTTP Server

© Informacja

In the following, please replace qgis . demo with the name or IP address of your server.

You can also use QGIS Server with NGINX. Unlike Apache, NGINX does not automatically spawn FastCGI

processes. The FastCGI processes are to be started by something else.

Install NGINX:

[apt install nginx

)

¢ As afirst option, you can use spawn-fcgi or fegiwrap to start and manage the QGIS Server processes. Official
Debian packages exist for both. When you have no X server running and you need, for example, printing, you
can use xvfb.

* Another option is to rely on Systemd, the init system for GNU/Linux that most Linux distributions use today.
One of the advantages of this method is that it requires no other components or processes. It’s meant to be

simple, yet robust and efficient for production deployments.

NGINX Configuration

The include fastcgi_params; used in the previous configuration is important, as it adds the parameters from /etc/

nginx/fastcgi_params:

fastcgi_param QUERY_ STRING Squery_string;
fastcgi_param REQUEST_METHOD Srequest_method;
fastcgi_param CONTENT_TYPE Scontent_type;
fastcgi_param CONTENT_LENGTH Scontent_length;
fastcgi_param SCRIPT_NAME Sfastcgi_script_name;
fastcgi_param REQUEST_URI Srequest_uri;
fastcgi_param DOCUMENT_URI Sdocument_uri;
fastcgi_param DOCUMENT_ROOT Sdocument_root;
fastcgi_param SERVER_PROTOCOL Sserver_protocol;
fastcgi_param REQUEST_SCHEME Sscheme;
fastcgi_param HTTPS Shttps if_not_empty;
fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;
fastcgi_param REMOTE_ADDR Sremote_addr;
fastcgi_param REMOTE_PORT Sremote_port;
fastcgi_param SERVER_ADDR $Sserver_addr;
fastcgi_param SERVER_PORT Sserver_port;
fastcgi_param SERVER_NAME Sserver_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Moreover, you can use some Environment variables to configure QGIS Server. In the NGINX configuration file, /
etc/nginx/nginx.conf, you have to use fastcgi_param instruction to define these variables as shown

below:

2.1. Installation on Debian-based systems
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location /ggisserver {
gzip ;
include fastcgi_params;
fastcgi_param QGIS_SERVER_LOG_STDERR 1;
fastcgi_param QGIS_SERVER_LOG_LEVEL 0;
fastcgi_pass unix:/var/run/qgisserver.socket;

FastCGIl wrappers

A\ Ostrzezenie

fegiwrap is easier to set up than spawn-fegi, because it’s already wrapped in a Systemd service. But it also leads
to a solution that is much slower than using spawn-fcgi. With fcgiwrap, a new QGIS Server process is created on
each request, meaning that the QGIS Server initialization process, which includes reading and parsing the QGIS
project file, is done on each request. With spawn-fcgi, the QGIS Server process remains alive between requests,
resulting in much better performance. For that reason, spawn-fcgi is recommended for production use.

spawn-fcgi

If you want to use spawn-fcgi:

1. The first step is to install the package:

[apt install spawn-fcgi }

2. Then, introduce the following block in your NGINX server configuration:

location /ggisserver {
gzip i
include fastcgi_params;
fastcgi_pass unix:/var/run/ggisserver.socket;

3. And restart NGINX to take into account the new configuration:

[systemctl restart nginx J

4. Finally, considering that there is no default service file for spawn-fcgi, you have to manually start QGIS Server
in your terminal:

spawn-fcgi —-s /var/run/qggisserver.socket \
-U www—data -G www-data -n \
/usr/lib/cgi-bin/qgis_mapserv.fcgi

QGIS Server is now available at http://qgis.demo/qgisserver.

© Informacja

When using spawn-fcgi, you may directly define environment variables before running the server. For example:
export QGIS_SERVER_LOG_STDERR=1

Of course, you can add an init script to start QGIS Server at boot time or whenever you want. For example with
systemd:

1. Edit the file /etc/systemd/system/ggis—-server.service with this content:

10 Rozdziat 2. Pierwsze kroki
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-
[Unit]

Description=QGIS server
After=network.target

[Service]

;; set env var as needed
;Environment="LANG=en_EN.UTF-8"
;Environment="QGIS SERVER PARALLEIL RENDERING=1"
;Environment="QGIS_ SERVER MAX THREADS=12"
;Environment="QGIS_SERVER LOG_LEVEL=0"
;Environment="QGIS_SERVER ILOG_STDERR=1"

;; or use a file:
;EnvironmentFile=/etc/qgis—server/env

ExecStart=spawn-fcgi -s /var/run/qgisserver.socket -U www-data -G www—-data -n /
—usr/lib/cgi-bin/ggis_mapserv. fcgi

[Install]
WantedBy=multi-user.target
.

2. Then enable and start the service:

[systemctl enable --now ggis-server ]

A\ Ostrzezenie

With the above commands spawn-fcgi spawns only one QGIS Server process.

fcgiwrap

Using fcgiwrap is much easier to setup than spawn-fegi but it’s much slower.

1. You first have to install the corresponding package:

[apt install fcgiwrap }

2. Then, introduce the following block in your NGINX server configuration:

1 ( location /ggisserver { ]
2 gzip off;

3 include fastcgi_params;

4 fastcgi_pass unix:/var/run/fcgiwrap.socket;

5 fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;

6 }

3. Finally, restart NGINX and fegiwrap to take into account the new configuration:

systemctl restart nginx

systemctl restart fcgiwrap
. J

QGIS Server is now available at http://qgis.demo/qgisserver.
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Systemd

QGIS Server needs a running X Server to be fully usable, in particular for printing. In the case you already have a
running X Server, you can use systemd services.

This method, to deploy QGIS Server, relies on two Systemd units to configure: a Socket unit and a Service unit.

1. The QGIS Server Socket unit defines and creates a file system socket, used by NGINX to start and
communicate with QGIS Server. The Socket unit has to be configured with Accept=false, meaning that
the calls to the accept () system call are delegated to the process created by the Service unit. It is located in
/etc/systemd/system/ggis—-server@. socket, which is actually a template:

p
[Unit]
Description=QGIS Server Listen Socket (instance %i)

[Socket]
Accept=false
ListenStream=/var/run/qgis—-server—-%i.sock
SocketUser=www-data

SocketGroup=www—-data

SocketMode=0600

[Install]
WantedBy=sockets.target
.

2. Now enable and start sockets:

[for iin 1 2 3 4; do systemctl enable --now ggis-server@$i.socket; done ]

3. The QGIS Server Service unit defines and starts the QGIS Server process. The important part is that the
Service process’ standard input is connected to the socket defined by the Socket unit. This has to be configured
using StandardInput=socket inthe Service unit configuration located in /et c/systemd/system/
ggis—-server@.service

[Unit]
Description=QGIS Server Service (instance %i)

[Service]

User=www—-data

Group=www—data

StandardOutput=null

StandardError=journal

StandardInput=socket
ExecStart=/usr/lib/cgi-bin/ggis_mapserv.fcgi
EnvironmentFile=/etc/qgis—-server/env

[Install]
WantedBy=multi-user.target

© Informacja

The QGIS Server environment variables are defined in a separate file, /etc/ggis—server/env. It
could look like this:

QGIS_PROJECT_FILE=/etc/ggis/myproject.qgs
QOGIS_SE R_LOG_STDERR=1

QGIS_SERVER_LOG_LEVEL=3

4. Now start socket service:

12
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[for iin 1 2 3 4; do systemctl enable —--now ggis—-server@S$i.service; done

5. Finally, for the NGINX HTTP server, let’s introduce the configuration for this setup:

-
upstream ggis-server_backend {

server unix:/var/run/ggis-server-1.sock;
server unix:/var/run/qgis-server-2.sock;
server unix:/var/run/gqgis—-server—3.sock;
server unix:/var/run/qgis-server-4.sock;

server {

location /ggis-server {
gzip H
include fastcgi_params;
fastcgi_pass ggis—-server_backend;

}

.

6. Now restart NGINX for the new configuration to be taken into account:

[systemctl restart nginx

Thanks to Oslandia for sharing their tutorial.

2.1.3 Xvfb

QGIS Server needs a running X Server to be fully usable, in particular for printing. On servers it is usually

recommended not to install it, so you may use xvfb to have a virtual X environment.

If you're running the Server in graphic/X11 environment then there is no need to install xvfb. More info at https:

/Iwww.itopen.it/qgis-server-setup-notes/.

1. To install the package:

[apt install xvfb

2. Create the service file, /etc/systemd/system/xvfb. service, with this content:

[Unit]

Description=X Virtual Frame Buffer Service
After=network.target

[Service]

—noreset

[Install]
WantedBy=multi-user.target

ExecStart=/usr/bin/Xvfb :99 -screen 0 1024x768x24 —-ac +extension GLX +render -

3. Enable, start and check the status of the xvfb.service:

systemctl enable —--now xvfb.service
systemctl status xvfb.service

.

J

4. Then, according to your HTTP server, you should configure the DISPLAY parameter or directly use xvfb-run.

» Using Apache:
1. Add to your Fcgid configuration (see Apache HTTP Server):

2.1. Installation on Debian-based systems
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[chidlnitialEnv DISPLAY ":o9" J

2. Restart Apache for the new configuration to be taken into account:

[systemctl restart apache?2 J

e Using NGINX

— With spawn-fcgi using xvfb-run:

xvfb-run /usr/bin/spawn-fcgi —-f /usr/lib/cgi-bin/qggis_mapserv.fcgi \
-s /tmp/ggisserver.socket \
-G www—data -U www-data -n

— With the DISPLAY environment variable in the HTTP server configuration.

[fastcgi_param DISPLAY U299 ]

2.2 Installation on Windows

QGIS Server can also be installed on Windows systems using the OSGeo4W network installer (https://qgis.org/
resources/installation- guide/#windows).

A simple procedure is the following:
1. Download and run the OSGeo4W installer
2. Follow the ,,Advanced Install” and install the QGIS Desktop, QGIS Server apache and mod_fcgid packages.

& 0SGeodW Setup - Select Packages — O ot
Select Packages Fen Y
Select packages to install \‘/
Search | | Clear OKeep OPrev@®@Cur (O Ep View | Category
Category Cument MNew Bin? Smc?  Size Package
B Al £ Defautt

Commandine_Ltilities 4 Default
Desktop 4¥ Default

Libs &% Default

B Web & Default

24521 O 7520k apache: Apache Webserver
&¥23101 O 33 mod_fcgid: Apache FastCGl ASF module
& Skip nja nja 2,308k qggigdtr-server: QGIS Server long tem release)
Ax3241-2 O 1,294k  ggis-server: QGIS Server
& Skip nja nja 19023 gwc-services: QWC services
& Skip nja nja 3,066k gwc?: QGIS webclient 2
£ >

Hide absolete packages

- Frrma i

3. Apache is not directly installed as a service on Windows. You need to:

1. Right-click the 0SGeo4W.bat file at the root of the C: \OSGeo4W\ folder (if the default installation
paths have been used) and select Run as administrator

2. In the console, run apache—install.bat, which will output
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> apache-install.bat

Installing the 'Apache 0SGeo4W Web Server' service

The 'Apache 0SGeod4W Web Server' service is successfully installed.
Testing httpd.conf....

Errors reported here must be corrected before the service can be started.

The service is started as you can notice in the report. But the server may fail to run due to missing custom
configuration.

4. Edit the C:\0SGeo4w\apps\apache\conf\httpd.conf file with the following changes (various
other combinations are possible):

Tabela 2.1: Apache configuration update

Cel Existing config Replacement

(Optional) Customize the address

to listen to using an IP and/or rListen ${SRVPORT} Listen localhost:8080
port, You can and add as many

entries as you wish.

Indicate where to find the script

files ScriptAlias /cgi-bin/ "$ |ScriptAlias /cgi-bin/
—{SRVROOT}/cgi-bin/" —"C:/0SGeodW/apps/qgis/
—bin/"

Provide permissions on the script

folder <Directory "S${SRVROOT}/ <Directory "C:/0SGeodW/
—cgi-bin"> —apps/ggis/bin">
AllowOverride None SetHandler cgi-
Options None —script
Require all granted AllowOverride None
</Directory> Options ExecCGI
Require all granted
</Directory>

Enable file extensions to use

for script files. Uncomment and | #adgrandier cgi-script . |AddHandler cgi-script
complete —cgi —cgl .exe

Add more OSGeo4W custom

configuration variables # parse 0SGeo4W apache. # parse 0SGeo4W apache.
—conf files —conf files
IncludeOptional "C:/ IncludeOptional "C:/
—0SGeo4W/httpd.d/httpd_ —0SGeodW/httpd.d/httpd_
—*.conf" —*.conf"
SetEnv GDAL_DATA "C:/
—~0SGeod4W/share/gdal"

SetEnv QGIS_AUTH_DB_DIR_
—PATH "C:/0SGeo4dW/apps/
—ggis/resources"

# default QOGIS project
SetEnv QGIS_PROJECT.
—FILE "C:/Users/*Your.
— USERNAME* /qgis_
—projects/qgis-server—
—tutorial-data/world.
—qgs"

5. Restart the Apache web server
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[> apache-restart.bat }

6. Let’s add a sample project. You can use your own, or one from Training demo data. Make sure that you place
it in the same folder that your QGIS_PROJECT_FILE environment variable is pointing to:

[> "C:/Users/*Your USERNAME*/qggis_projects/qggis-server-tutorial-data/world.qggs" }

7. Open browser window to testing a GetCapabilities request to QGIS Server. Replace 1localhost : 8080 with
the IP and port you set to listen.

http://localhost:8080/cgi-bin/ggis_mapserv.fcgi.exe?SERVICE=WMS&VERSION=1.3.0&
—REQUEST=GetCapabilities

R

A XML file with the capabilities should be returned. Your server is ready to use.

2.3 Serve a project

Now that QGIS Server is installed and running, we just have to use it.

Obviously, we need a QGIS project to work on. Of course, you can fully customize your project by defining contact
information, precise some restrictions on CRS or even exclude some layers. Everything you need to know about that
is described later in Configure your project.

But for now, we are going to use a simple project already configured and previously downloaded in /home /qgis/
projects/world.ggs, as described above.

By opening the project and taking a quick look on layers, we know that 4 layers are currently available:
* airports
* places
* countries
e countries_shapeburst

You don’t have to understand the full request for now but you may retrieve a map with some of the previous layers
thanks to QGIS Server by doing something like this in your web browser to retrieve the countries layer:

* If you followed the above instructions to install an Apache HTTP Server:

e Y
http://qggis.demo/cgi-bin/qgis_mapserv.fcgi?MAP=/home/qgis/projects/world.qgsé&
—LAYERS=countries&SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&CRS=EPSG:4326&
—WIDTH=400&HEIGHT=200&BBOX=-90,-180, 90, 180

L J

If you followed the above instructions to install an NGINX HTTP Server:

~

-
http://qggis.demo/ggisserver?MAP=/home/qgis/projects/world.qgs&LAYERS=countriesé&
—SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&CRS=EPSG:4326&WIDTH=400&HEIGHT=200&
—BBOX=-90,-180, 90,180

If you followed the instructions for Windows:

http://localhost:8080/cgi-bin/ggis_mapserv.fcgi.exe?SERVICE=WMS&
—LAYERS=countries&VERSION=1.3.0&REQUEST=GetMap&CRS=EPSG:4326&WIDTH=400&
—HEIGHT=200&BB0OX=-90,-180, 90, 180

If you obtain the next image, then QGIS Server is running correctly:
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Rys. 2.1: Server response to a basic GetMap request

Note that you may define QGIS_PROJECT_FILE environment variable to use a project by default instead of giving
a MAP parameter (see Environment variables).

For example with spawn-fcgi:

export QOGIS_PROJECT_FILE=/home/qgis/projects/world.qgs
spawn-fcgi -f /usr/lib/bin/cgi-bin/ggis_mapserv.fcgi \
-s /var/run/qgisserver.socket \
-U www—data -G www-data -n

2.4 Configure your project

To provide a new QGIS Server WMS, WES, OAPIF or WCS, you have to create a QGIS project file with some data
or use one of your current projects. Define the colors and styles of the layers in QGIS and the project CRS, if not
already defined. Then, go to the QGIS Server menu of the Project » Properties... dialog and provide some information
about the OWS in the Service Capabilities tab.

2.4. Configure your project 17
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Project Properties — QGIS Server X
Services Capabilities | WMS = WMTS WFS/OAPIF =~ WCS 3
\'--..__ General v |v| Enable Service Capabilities
a Metadata These parameters are used to generate the GetCapabilities document and shall be
chosen carefully to avoid interoperability and security issues.
View Settings Y P by =
Short name A name used to identify the root layer. The short name is a text ...
Title The title should be brief yet descriptive enough to identify this ...
#2 Transformations _
Organization The name of the service provider.
=/
e e Online resource  |The web site URL of the service provider. =i
B8 Data Sources Person The contact person name for the service.
EE Relations Position -
Variables E-Mail The contact person e-mail for the service.
@ Phone The contact person phone for the service.
s Macros
=
= " QGIS Server
Abstract
Fees Conditions Unknown -
Access constraints |[None v
Keyword list List of keywords separated by comma to help catalog searching.
Tesk Configuration
Launch
©Help @apply || @cancel

Rys. 2.2: Definitions for a QGIS Server WMS/WFS/WCS project

You have to Enable Service Capabilities first, if it is deactivated. This will appear in the GetCapabilities response of

the WMS, WFS or WCS. If you don’t check o Enable Service capabilities, QGIS Server will use the information
given in the wms_metadata.xml file located in the cgi-bin folder.
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2.4.1 WMS capabilities

Project Properties — QGIS Server
Services Capabilities | WMS | WMTS = WFS/OAPIF | WCS

\'..__ General w V| Advertised extent

& Metadata -6413275.3590,6751261.3334,2496221.8705,7575689.2244 [EPS5G:2964] B [~
[8# view settings » |¥| CRS restrictions

> Exclude layouts b Exclude layers
f',! Transformations > INSPIRE (European directive)
w Layer and Feature options

Use layer ids as names

Use attribute form settings for GetFeatureInfo response
==}
B8 Data Sources

Add geometry to feature response
g Relations Segmentize feature info geometry
variables GetFeatureInfo geometry precision (decimal places) 8 -

@ Macros Advertised URL
() =

!-‘- QGIS Server w Map and Legend Options

a Temporal Add layer groups in GetlLegendGraphic

Skip name attribute for groups

=I Elevation

Maximum image size for GetMap and GetLegendGraphic requests
Sensors

Width Height

Quality for JPEG and WebP images (from 0 to 100; 0 - smaller size, 100 - better quality) | 90 -

Maximum features for Atlas print requests 1 -
Tile buffer in pixels 0 -
Default scale for legend 1:305 -

Test Configuration

Launch

18 pide + Ok + Appliquer | | © Annuler

Rys. 2.3: Definitions in the WMS tab

In the WMS tab, you can define the options for the WMS capabilities.

* Check Advertised extent to define the extent advertised in the WMS GetCapabilities response. The spatial extent
selector widget helps you enter the extent as a xmin, xmax, ymin, ymax textor pick it from the map
canvas, layers, bookmarks. ..

* By checking . CRS restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server
will offer to render maps. It is recommended that you restrict the offered CRS as this reduces the size of the

WMS GetCapabilities response. Use the I:Il'l:l-l:I button below to select those CRSs from the Coordinate Reference
System Selector, or click Used to add the CRSs used in the QGIS project to the list.

* If you have print layouts defined in your project, they will be listed in the GetProject Settings response,
and they can be used by the GetPrint request to create prints, using one of the print layouts as a template. This
is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print layout from being

published by the WMS, check oA Exclude layouts and click the EI-T-J button below. Then, select a print layout
from the Select print layout dialog in order to add it to the excluded layouts list.
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* If you want to exclude any layer or layer group from being published by the WMS, check i Exclude Layers

and click the Ifl'l:ll-:| button below. This opens the Select restricted layers and groups dialog, which allows you to
choose the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want
to select multiple entries. It is recommended that you exclude from publishing the layers that you don’t need
as this reduces the size of the WMS GetCapabilities response which leads to faster loading times on the client
side.

* Layer and Feature Options

You can receive requested GetFeaturelnfo as plain text, XML and GML. The default is XML.

— If you check o Use layer ids as name, layer ids will be used to reference layers in the
GetCapabilities response or GetMap LAYERS parameter. If not, layer name or short name
if defined (see vectorservermenu) is used.

By default, layer names are used to expose layers through WMS. If multiple layers have the same name,
they will be merged to a single WMS layer and cannot be requested individually. You need to take care
of these layers being compatible with each other. Using the Use layer ids as name option ensures that
multiple layers with the same name can be requested as individual layers.

— If you wish, you can check oA Add geometry to feature response. This will include the bounding box for
each feature in the GetFeaturelnfo response. See also the WITH_GEOMETRY parameter.

— As many web clients can’t display circular arcs in geometries you have the option to segmentize the
geometry before sending it to the client in a GetFeaturelnfo response. This allows such clients to still

display a feature’s geometry (e.g. for highlighting the feature). You need to check the C.4 Segmentize
feature info geometry to activate the option.

— You can also use the GetFeaturelnfo geometry precision option to set the precision of the GetFeaturelnfo
geometry. This enables you to save bandwidth when you don’t need the full precision.

— If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside
the GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will
also be shown in the GetFeaturelnfo output.

— If you want QGIS Server to advertise specific request URLs in the WMS GetCapabilities response, enter
the corresponding URL in the Advertised URL field.

e Map and Legend Options

— When a layer group is passed to GetLegendGraphic request, all of its leaf layers are added to the

legend picture (however without the groups» labels). Check the i Add layer groups in GetLegendGraphic
option if you want to also insert the layer groups (and subgroups) names into the layer tree, just like in
QGIS Desktop legend.

— When QGIS project contains layer groups, they are listed in WMS capabilities document alongside with
layers. If a group (its name as listed in capabilities) is included in WMS GetMap LAYERS parameter
alongside with names of layers in that group, QGIS would duplicate the layers: once for the group and

once for specific layer. If you check the oA Skip name attribute for groups option, GetCapabilities will
only return title attribute for the group but not its name attribute, making it impossible to include groups
in list of layers of GetMap request.

— Furthermore, you can restrict the maximum size of the maps returned by the requests by entering
the maximum width and height into the respective fields under Maximum image size for GetMap and
GetLegendGraphic requests.

— You can change the Quality for JPEG and WebP images factor. The quality factor must be in the range 0
to 100. Specify 0 for maximum compression, 100 for no compression.

— You can change the limit for atlas features to be printed in one request by setting the Maximum features
for Atlas print requests field.

— When QGIS Server is used in tiled mode (see TILED parameter), you can set the Tile buffer in pixels.
The recommended value is the size of the largest symbol or line width in your QGIS project.
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— Depending on whether the map uses a projected CRS or a geographic CRS and if there is no information
to evaluate the map unit sized symbols, you can provide reference for size through either a Default scale
for legend or Default map units per mm in legend.

2.4.2 WMTS capabilities
In the WMTS tab you can select the layers you want to publish as WMTS and specify if you want to publish as PNG
or JPEG.

Under Grids, for each restricted CRS, you can indicate whether the tile matrices should be published and configure
their top-left corner, minimum and maximum scales and the last level of the tile matrices. Note that for EPSG: 3857
and EPSG: 4326 CRS, only the last level of the tile matrices can be edited.

You can also set a Minimum scale for the tiles display.
If you enter a URL in the Advertised URL field, QGIS Server will advertise this specific URL in the WMTS

GetCapabilities response.

[ ] [ ] Project Properties — QGIS Server

Services Capabilities WMS WMTS WFS/OAPIF WCS

\‘-.____ General ¥ Published layers
!‘ Metadata Layer ~ Published PNG JPEG
~ Project
] view Setti Cartographie biométhane d'accés aux réseaux
I view settings BDTOPO_V3:batiment v v v
— BDCARTO_V5:commune
€5 CRs : i
= Acces aux services postaux
ﬂ‘;' Transformations
“V"’ Styles
@ Colors
¥ Grids
i Data Sources
S CRS ~ Published Top Left Min.scale Last level Max.scale
= Relations EPSG:4326 v 90 -180 2.79541e+08 18 1066.36
EPSG:3857 2.00375e+07 -2.00375e+07 5.58082e+08 18 2132.73
Variables EPSG:2964 2.38453e+06 -7.4055e+08 0 18 0
EPSG:2154 v 8.31927+06 -1.22764e+06 4.68207e+07 18 178.607
Cl® Macros
=
&', QCIS Server
Elevation Minimum scale 5000 -
Sensors Advertised URL

Test Configuration

Launch

Help Apply Cancel OK

Rys. 2.4: Definitions in the WMTS tab
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2.4.3 WFS/OAPIF capabilities

In the WFS/OAPIF tab, you can select the layers you want to publish as WFS or OAPIF, and specify if they will allow
update, insert and delete operations.

Project Properties — QGIS Server X
Services Capabilities = WMS = WMTS | WFS/OAPIF | wCS
\'--..__ General The WFS capabilities also influences DXF export
! Metadata . Layer. Published Geometry precision Update Insert
0 shapefiles — airports 8 =
View Settings 1 |shapefiles —alaska 8 =
.5:?’-: CRS 2 shapefiles — builtups 8 -
P 3 climate 8 =
o i 3
e Transformations Bl v — elevp 8 -
% Default styles 5 shapefiles —grassland 8 =
6 shapefiles — lakes 8 =
E Data Sources
- 7 shapefiles — landice 8 -
g Relations 8 | shapefiles — majrivers 8 =
Variables 9 shapefiles — pipelines 8 =
& 10 shapefiles — popp 8 =
¥} Macros
bl 11 shapefiles — railroads 8 =
Q-! QGIS Server 12 shapefiles — regions 8 -
a. L — 13 |shapefiles —rivers 8 =
' 14 shapefiles — storagep 8 =
15 shapefiles — swamp 8 -
16 shapefiles — trails 8 =
17 shapefiles — trees 8 =
18 shapefiles — tundra 8 -
1 2
Publish all Unpublish All
Advertised URL
Teskt Configuration
Launch
@ Help @napply | @cancel

Rys. 2.5: Definitions in the WFS/OAPIF tab

If you enter a URL in the Advertised URL field, QGIS Server will advertise this specific URL in the WFS
GetCapabilities response.
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2.4.4 WCS capabilities

In the WCS tab, you can select the layers that you want to publish as WCS.

If you enter a URL in the Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific

URL in the WCS GetCapabilities response.

Services Capabilities

N

. General Layer

- 0 Bing Ma
a Metadata gMap

& view Settings

#2 Transformations
% Default Styles
[= =)

B8 Data Sources

EE Relations

Variables

{;-.-G) Macros

!-! QGIS Server

ﬁ- Temporal

Advertised URL

Tesk Configuration

Launch

©Help

WMS

Published

Select All

Project Properties — QGIS Server

WMTS = WFS/OAPIF

x
WCS
Deselect All
©apply | Ocancel

Rys. 2.6: Definitions in the WCS tab

2.4. Configure your project
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2.4.5 Fine tuning your OWS

Apart from configuring metadata individually for each layer, in QGIS you can fine tune your group of WMS layers.
This is useful if you want the group to appear as a single entity in the WMS GetCapabilities, instead of exposing
only its child layers. By setting metadata at the group level, you can provide a clearer description of related layers and
improve the usability of your service. To configure metadata for a group of layers:

1. In the Layers panel, right-click the desired layer group and select Set Group WMS Data.
2. In the dialog that opens, fill in the information:

* a Description: the abstract of the layer group.

* a Attribution: the attribution of the layer group.

* a Metadata URL: the URL of a metadata document for the layer group.

* a Legend URL: the URL of a legend image for the layer group.

3. Optionally, you can check i Compute TIME dimension from children to have QGIS Server compute the TIME
dimension for the group based on the TIME dimensions of its child layers.

For vector layers, the Fields tab of the Layer » Layer Properties dialog allows you to define for each attribute if it will
be published or not. By default, all the attributes are published by your WMS and WES. If you don’t want a specific
attribute to be published, uncheck the appropriate checkbox in the Configuration column:

* Do not expose in WFS
* Do not expose in WMS

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the sec_annotations section for instructions on creating annotations. For annotations to be
displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation text dialog must be
unchecked. This can be accessed by double clicking the annotation while one of the annotation tools is active. For
SVG annotations, you will need either to set the project to save absolute paths (in the General menu of the Project »
Properties... dialog) or to manually modify the path to the SVG image so that it represents a valid relative path.

2.5 Integration with third parties

QGIS Server provides standard OGC web services like WMS, WES, etc. thus it can be used by a wide variety of end
user tools.

2.5.1 Integration with QGIS Desktop

QGIS Desktop is the map designer where QGIS Server is the map server. The maps or QGIS projects will be served
by the QGIS Server to provide OGC standards. These QGIS projects can either be files or entries in a database (by
using Project » Save to » PostgreSQOL in QGIS Desktop).

Furthermore, dedicated update workflow must be established to refresh a project used by a QGIS Server (ie. copy
project files into server location and restart QGIS Server). For now, automated processes (as server reloading over
message queue service) are not implemented yet.

24 Rozdziat 2. Pierwsze kroki


https://www.ogc.org/standards

QGIS Server 3.44 User Guide

2.5.2 Integration with MapProxy

MapProxy is a tile cache server and as it can read and serve any WMS/WMTS map server, it can be directly connected
to QGIS server web services and improve end user experience.

2.5.3 Integration with QWC2

QWC?2 is a responsive web application dedicated to QGIS Server. It helps you to build a highly customized map
viewer with layer selection, feature info, etc.. Also many plugins are available like authentication or print service, the
full list is available in this repository.
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Ustugi

QGIS Server is able to serve data according to standard protocols as described by the Open Geospatial Consortium
(OGCO):

e WMS I1.1.1 and 1.3.0

* WFS1.0.0and 1.1.0

¢ OGC API - Features (WFS3)
* WCS1.0.0and 1.1.1

* WMTS 1.0.0

Extra vendor parameters and requests are supported in addition to the original standard that greatly enhance the
possibilities of customizing its behavior thanks to the QGIS rendering engine.

3.1 Basics

This section describes concepts and parameters mutually shared by services. Some of these are standard and defined
in OGC specifications while others are very specific to QGIS Server.

Standard concepts:

Concept  Opis

SERVICE Name of the service
REQUEST  Name of the request

Vendor concepts:

Concept Opis

MAP Plik projektu QGIS
FILE_NAME File name of the downloaded file
Short name Short name definition
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3.1.1 SERVICE

This standard parameter allows to specify the name of the service to use for a specific request and has to be formed
like SERVICE=NAME.

URL example for the WMS service:

http://localhost/ggisserver?
SERVICE=WMS
&ooo

© Informacja

Not available for REST based services like WFS3 (OGC API Features).

3.1.2 REQUEST

This standard parameter allows to specify the name of the request to execute for a specific service and has to be
formed like REQUEST=RequestName.

URL example for the GetCapabilities request:

http://localhost/ggisserver?
REQUEST=GetCapabilities
&o oo

© Informacja

Not available for REST based services like WFS3 (OGC API Features).

3.1.3 MAP

This vendor parameter allows to define the QGIS project file to use. It may be an absolute path or a path relative to the
location of the server executable qgis_mapserv. fcgi. MAP is mandatory by default because a request needs a
QGIS project to actually work. However, the QGIS_PROJECT_FILE environment variable may be used to define
a default QGIS project. In this specific case, MAP is no longer a required parameter. For further information you may
refer to the Advanced configuration chapter.

Przyktad URL:

http://localhost/ggisserver?
MAP=/tmp/QGIS-Training-Data/exercise_data/ggis-server-tutorial-data/world.qggs
&...

3.1.4 FILE_NAME

If this vendor parameter is set, the server response will be sent to the client as a file attachment with the specified file
name.

URL example to save an XML GetCapabilities document:

http://localhost/qggisserver?
SERVICE=WMS
&REQUEST=GetCapabilities

(ciag dalszy na nastgpnej stronie)
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(kontynuacja poprzedniej strony)
&FTILE_NAME=wms_capabilities.xml
&ooo

© Informacja

Not available for REST based services like WFS3 (OGC API Features).

3.1.5 Short name

A number of elements have both a short name and a title. The short name is a text string used for machine-to-machine
communication while the title is for the benefit of humans. For example, a dataset might have the descriptive title
“Maximum Atmospheric Temperature” and be requested using the abbreviated short name “ATMAX”. You can set title,
short name and abstract for:

¢ Layers: right-click on a layer and choose Properties... » QGIS Server » Description.
* Groups: right-click on a group and select Set Group WMS data

¢ Project: go to Project » Properties... » QGIS Server » Service Capabilities.

0 Set group WMS data

Short name

Title

Abstract
| Cancel Save
Rys. 3.1: Set group WMS data dialog

Thus, the short name may be used to identify these items when interacting with QGIS Server. For example with the
standard LAYERS parameter:

http://localhost/gqgisserver?
SERVICE=WMS

&REQUEST=GetMap
&LAYERS=shortnamel, shortname2
&...

3.2 Web Map Service (WMS)

The 1.1.1 and 1.3.0 WMS standards implemented in QGIS Server provide a HTTP interface to request map or legend
images generated from a QGIS project. A typical WMS request defines the QGIS project to use, the layers to render
as well as the image format to generate. Basic support is also available for Styled Layer Descriptor (SLD).

Specyfikacje:
e WMS 1.1.1
* WMS 1.3.0
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e SLD 1.1.0 WMS profile

Standardowe Zzadania dostarczane przez QGIS Server :

Zapytanie Opis

GetCapabilities Zwraca metadane XML zawierajace informacje o serwerze

GetMap Zwraca mapeg

GetFeaturelnfo Pobiera dane (geometri¢ i wartosci) dla lokalizacji piksela

GetLegendGraphic Zwraca symbole legendy

GetStyle(s) Zwraca dokument XML z opisem stylu w SLD

DescribeLayer Zwraca informacje o dostgpnosci WFS i WCS odpowiednio dla warstw

wektorowych i rastrowych

Zadania dostawcow udostepniane przez QGIS Server:

Zapytanie Opis

GetPrint Zwraca rozktad wydruku QGIS

GetProjectSettings Zwraca szczegotowe informacje o serwerze QGIS

GetSchemaExtension Zwraca metadane XML dotyczace opcjonalnych rozszerzonych mozliwosci

3.2.1 GetCapabilities

Standard parameters for the GetCapabilities request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

Parametr Wymagany Opis

SERVICE  Tak Name of the service (WMS)
REQUEST Tak Nazwa zapytania (GetCapabilities)
VERSION  Nie Version of the service

The GetCapabilities request supports as well the following vendor parameters:

Parametr Wymagany Opis
MAP Tak Plik projektu QGIS

Przyktad URL:

http://localhost/ggisserver?
SE =WMS

&VER N=1.3.0
&REQUEST=GetCapabilities

3.2.2 GetMap

Standard parameters for the GetMap request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

Parametr Wymagany Opis
SERVICE Tak Name of the service (WMS)
REQUEST Tak Name of the request (GetMap)
VERSION Tak Version of the service
cigg dalszy na nastepnej stronie
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Tabela 3.1 - kontynuacja poprzedniej strony

Parametr Wymagany Opis

LAYERS Nie Warstwy do wyswietlenia

STYLES Nie Styl warstw

SRS / CRS Tak Uktad wspétrzednych

BBOX Tak Zasigg mapy

WIDTH Tak Szeroko$¢ obrazu w pikselach

HEIGHT Tak Wysokos$¢ obrazu w pikselach

FORMAT Nie Format obrazu

TRANSPARENT Nie Przezroczyste tto

SLD Nie Adres URL pliku SLD, ktéry ma by¢ uzywany do stylizacji
SLD_BODY Nie In-line SLD (XML) do wykorzystania w stylizacji

In addition to the standard ones, QGIS Server supports redlining, external WMS layers as well as the following extra
parameters:

Parametr Wymagany Opis
MAP Tak Plik projektu QGIS
BGCOLOR Nie Specify the background color
DPI Nie Specify the output resolution
IMAGE_QUALITY Nie JPEG compression
OPACITIES Nie Opacity for layer or group
FILTER Nie Subset of features
SELECTION Nie Highlight features
FILE_NAME Nie File name of the downloaded file
Only for FORMAT=application/dxf
FORMAT _OPTIONS Nie Options of the specified file format
Only for FORMAT=application/dxf
TILED Nie Working in tiled mode
Przyktad URL:

http://localhost/qggisserver?
SERVICE=WMS
TON=1.3.0
&REQUEST=GetMap
&MAP=/home/qgis/projects/world.qgs
&LAYERS=mylayerl,mylayer2,mylayer3
&STYLES=stylel,default,style3
ACITIES=125,200,125
=EPSG:4326
&WIDTH=400
&HEIGHT=400

ORMAT=image/png

SPARENT=TRUE

&TILED=TRUE
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VERSION

This parameter allows to specify the version of the service to use. Available values for the VERSION parameter are:
e 1.1.1
*1.3.0

According to the version number, slight differences have to be expected as explained later for the next parameters:
e CRS/ SRS

¢ BBOX

LAYERS

This parameter allows to specify the layers to display on the map. Names have to be separated by a comma.
In addition, QGIS Server introduced some options to select layers by:

« the layer id: the project option allowing to select layers by their id is in QGIS Server » WMS tab of the Project
» Properties... dialog. Check the Use layer ids as names checkbox to activate this option.

¢ a short name

http://localhost/ggisserver?

SERVICE=WMS

&REQUEST=GetMap
&LAYERS=mylayeridl,mylayerid?2
&. ..

STYLES

This parameter can be used to specify a layer’s style for the rendering step. Styles have to be separated by a comma.
The name of the default style is default.

SRS /CRS

This parameter allows to indicate the map output Spatial Reference System in WMS 1.1.1 and has to be formed like
EPSG: XXXX. Note that CRS is also supported if current version is 1.1.1.

For WMS 1.3.0, CRS parameter is preferable but SRS is also supported.

Note that if both CRS and SRS parameters are indicated in the request, then it’s the current version indicated in
VERSION parameter which is decisive.

In the next case, the SRS parameter is kept whatever the VERSTON parameter because CRS is not indicated:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0
&SRS=EPSG:2854

&o oo

In the next case, the SRS parameter is kept instead of CRS because of the VERSION parameter:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.1.1
&CRS=EPSG:4326

(ciag dalszy na nastgpnej stronie)
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(kontynuacja poprzedniej strony)
&SRS=EPSG:2854
&ooo

In the next case, the CRS parameter is kept instead of SRS because of the VERSION parameter:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0

CRS=EPSG:4326
&SRS=EPSG:2854

BBOX
This parameter allows to specify the map extent with units according to the current CRS. Coordinates have to be
separated by a comma.

The BBOX parameter is formed like min_a, min_b,max_a,max_b but a and b axis definition is different
according to the current VERS ION parameter:

¢ in WMS 1.1.1, the axis ordering is always east/north
e in WMS 1.3.0, the axis ordering depends on the CRS authority

For example in case of EPSG: 4326 and WMS 1.1.1, a is the longitude (east) and b the latitude (north), leading to
a request like:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.1.1
&SRS=epsg:4326
&BBOX=-180,-90, 180, 90

&...

But in case of WMS 1.3.0, the axis ordering defined in the EPSG database is north/east so a is the latitude and b the
longitude:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0
&CRS=epsg:4326
&BBOX=-90,-180, 90,180

&...

WIDTH

This parameter allows to specify the width in pixels of the output image.
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HEIGHT

This parameter allows to specify the height in pixels of the output image.

FORMAT

This parameter may be used to specify the format of map image. Available values are:
* Jpg
* jpeg
* image/jpeg
* image/png
* image/png; mode=1bit
* image/png; mode=8bit
* image/png; mode=16bit
* image/webp
* application/dx£: only layers that have read access in the WES service are exported in the DXF format
* application/pdf
Przyktad URL:

g
http://localhost/ggisserver?

&LAYERS=Haltungen,Normschacht, Spezialbauwerke

&CRS=EPSG%3A21781
696136.28844801,245797.12108743,696318.91114315,245939.25832905
&WIDTH=1042

&HEIGHT=811

&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY; SCALE:250
&FILE_NAME=plan.dxf

TRANSPARENT

This boolean parameter can be used to specify the background transparency. Available values are (not case sensitive):
e TRUE
e FALSE

However, this parameter is ignored if the format of the image indicated with FORMAT is different from PNG.

BGCOLOR

This parameter allows to indicate a background color for the map image. However it cannot be combined with
TRANSPARENT parameter in case of PNG images (transparency takes priority). The colour may be literal or in
hexadecimal notation.

URL example with the literal notation:
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http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0
&BCCOLOR=green

&ooo

URL example with the hexadecimal notation:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=0x00FF00

&...

DPI

This parameter can be used to specify the requested output resolution.

IMAGE_QUALITY

This parameter is only used for JPEG images. By default, the JPEG compression is —1.

You can change the default per QGIS project in the OWS Server » WMS capadbilities menu of the Project » Properties...
dialog. If you want to override it in a GetMap request you can do it using the IMAGE_QUALITY parameter.

OPACITIES

Comma separated list of opacity values. Opacity can be set on layer or group level. Allowed values range from 0

(fully transparent) to 255 (fully opaque).
Przyktad URL:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0

&WIDTH=400

&HEIGHT=200

&CRS=EPSG:4326
&LAYERS=countries,places
&BBOX=42,-6,52,15
&OPACITIES=255,0

=

. Andorra
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-

Rys. 3.2: To the left OPACITIES=255, 0 and to the right OPACITIES=255, 255
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FILTER

A subset of layers can be selected with the FILTER parameter. The syntax is basically the same as for the QGIS
subset string. However, there are some restrictions to avoid SQL injections into databases via QGIS Server. If a
dangerous string is found in the parameter, QGIS Server will return the next error:

<ServiceExceptionReport>

<ServiceException code="Security">The filter string XXXXXXXXX has been rejected.
—because of security reasons.

Note: Text strings have to be enclosed in single or double quotes. A space.
—between each word / special character is mandatory.

Allowed Keywords and special characters are IS,NOT,NULL,AND,OR,IN,=,<,=<,>,>=, 1=,
—',"'",(,),DMETAPHONE, SOUNDEX.

Not allowed are semicolons in the filter expression.</ServiceException>
</ServiceExceptionReport>

(. J

Przyktad URL:

http://localhost/ggisserver?

SERVICE=WMS

&REQUEST=GetMap

&VERSION=1.3.0

&WIDTH=400

&HEIGHT=300

&CRS=EPSG:4326

&BBOX=41,-6,52,10
&LAYERS=countries_shapeburst, countries, places

&FILTER=countries_shapeburst, countries:"name" = 'France';places: "name" = 'Paris'
(.- J

Rys. 3.3: Server response to a GetMap request with FILTER parameter

In this example, the same filter "name" = 'France' 1is applied to layers countries and
countries_shapeburst, while the filter "name" = 'Paris' isonly applied to places.

© Informacja

It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is there.
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L QGIS Server then returns info about the matching features and generates a combined bounding box in the XML J
output.

SELECTION

The SELECTION parameter can highlight features from one or more layers. Vector features can be selected by
passing comma separated lists with feature ids.

http://localhost/ggisserver?

SERVICE=WMS

&REQUEST=GetMap
&LAYERS=mylayerl,mylayer2
&SELECTION=mylayerl:3,6,9;mylayer2:1,5,6
&...

The following image presents the response from a GetMap request using the SELECTION option e.g. http://
myserver.com/...&SELECTION=countries:171, 65.

As those features id’s correspond in the source dataset to France and Romania they’re highlighted in yellow.

Poland

France

Rys. 3.4: Server response to a GetMap request with SELECTION parameter
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FORMAT_OPTIONS

This parameter can be used to specify options for the selected format. Only for FORMAT=application/dxf in
GetMap request. Takes a list of key:value pairs separated by semicolon:

¢ SCALE: to be used for symbology rules, filters and styles (not actual scaling of the data - data remains in the
original scale).

* MODE: corresponds to the export options offered in the QGIS Desktop DXF export dialog. Possible values
are NOSYMBOLOGY, FEATURESYMBOLOGY and SYMBOLLAYERSYMBOLOGY.

« LAYERATTRIBUTES: specify a field or in case of many layers a comma separated list of fields that contains
values for DXF layer names - if not specified, the original QGIS layer names are used.

o USE_TITLE_AS_LAYERNAME: if enabled, the title of the layer will be used as layer name.

* CODEC: specify a codec to be used for encoding. Default is ISO-8859~-1 check the QGIS desktop DXF
export dialog for valid values.

¢ NO_MTEXT: Use TEXT instead of MTEXT for labels.
¢ FORCE_2D: Force 2D output. This is required for polyline width.

TILED

For performance reasons, QGIS Server can be used in tiled mode. In this mode, the client requests several small fixed
size tiles, and assembles them to form the whole map. Doing this, symbols at or near the boundary between two tiles
may appeared cut, because they are only present in one of the tile.

Set the TILED parameter to TRUE to tell QGIS Server to work in filed mode, and to apply the Tile buffer configured
in the QGIS project (see Configure your project).

When TILED is TRUE and when a non-zero Tile buffer is configured in the QGIS project, features outside the tile
extent are drawn to avoid cut symbols at tile boundaries.

TILED defaults to FALSE.

3.2.3 GetFeaturelnfo

Standard parameters for the GetFeaturelnfo request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

Parametr Wymagany Opis

SERVICE Tak Name of the service (WMS)

REQUEST Tak Nazwa zapytania (GetFeatureInfo)
VERSION Nie Version of the service

QUERY_LAYERS Tak Layers to query

LAYERS Tak Layers to display (identical to QUERY_LAYERS)
STYLES Nie Styl warstw

SRS / CRS Tak Uktad wspoétrzednych

BBOX Nie Zasigg mapy

WIDTH Tak Szerokos¢ obrazu w pikselach

HEIGHT Tak Wysokos¢ obrazu w pikselach
TRANSPARENT Nie Przezroczyste tto

INFO_FORMAT Nie Format wynikowy

FEATURE _COUNT Nie Maximum number of features to return
I Nie Pixel column of the point to query

X Nie Same as I parameter, but in WMS 1.1.1
J Nie Pixel row of the point to query

Y Nie Same as J parameter, but in WMS 1.1.1

cigg dalszy na nastepnej stronie
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Tabela 3.3 - kontynuacja poprzedniej strony
Parametr Wymagany Opis
WMS_PRECISION Nie The precision (number of digits) to be used when returning
geometry (see how to add geometry to feature response). The

default value is —1 meaning that the precision defined in the
project is used.

Oprécz standardowych parametréw, QGIS Server obstuguje nastgpujace parametry dodatkowe:

Parametr Wymagany Opis
MAP Tak Plik projektu QGIS
FILTER Nie Subset of features
FI_POINT_TOLERANCE Nie Tolerance in pixels for point layers
FI_LINE_TOLERANCE Nie Tolerance in pixels for line layers
FI_POLYGON_TOLERANCE Nie Tolerance in pixels for polygon layers
FILTER_GEOM Nie Geometry filtering
WITH_DISPLAY_NAME Nie Add the feature display name to the output
WITH_MAPTIP Nie Add map tips to the output
WITH_GEOMETRY Nie Add geometry to the output
Przyktad URL:

http://localhost/ggisserver?
SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap
&MAP=/home/qgis/projects/world.qgs
&LAYERS=mylayerl,mylayer2,mylayer3
&CRS=EPSG:4326

&W H=400
&HEIGHT=400
&INFO_FORMAT=text/xml

T=TRUE

INFO_FORMAT

This parameter may be used to specify the format of the result. Available values are:
* text/xml
* text/html
* text/plain
* application/vnd.ogc.gml

e application/json
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QUERY_LAYERS

This parameter specifies the layers to display on the map. Names are separated by a comma.
In addition, QGIS Server introduces options to select layers by:

* short name

e layer id

See the LAYERS parameter defined in GerMap for more information.

FEATURE_COUNT

This parameter specifies the maximum number of features per layer to return. For example if QUERY_LAYERS is
set to layerl, layer2 and FEATURE_COUNT is set to 3 then a maximum of 3 features from layerl will be
returned. Likewise a maximum of 3 features from layer2 will be returned.

By default, only 1 feature per layer is returned.

This parameter, defined in WMS 1.3.0, allows you to specify the pixel column of the query point.

X

Same parameter as I, but defined in WMS 1.1.1.

J

This parameter, defined in WMS 1.3.0, allows you to specify the pixel row of the query point.

Y

Same parameter as J, but defined in WMS 1.1.1.

FI_POINT_TOLERANCE

This parameter specifies the tolerance in pixels for point layers.

FI_LINE_TOLERANCE

This parameter specifies the tolerance in pixels for line layers.

FI_POLYGON_TOLERANCE

This parameter specifies the tolerance in pixels for polygon layers.
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FILTER_GEOM

This parameter specifies a WKT geometry with which features have to intersect.

WITH_DISPLAY_NAME

This parameter specifies whether to add feature display name to the output.
Available values are (not case sensitive):
e TRUE

¢ FALSE

WITH_MAPTIP

This parameter specifies whether to add map tips to the output.
Available values are (not case sensitive):

e TRUE

e FALSE

e HTML_FI_ONLY_MAPTIP: like TRUE, with the difference that the HTML response to the feature info
request only contains the maptip. This gives full control over the HTML response using e.g. the built-in layer
maptip editor.

WITH_GEOMETRY

This parameter specifies whether to add geometries to the output. To use this feature you must first enable the Add
geometry to feature response option in the QGIS project. See Configure your project.
Available values are (not case sensitive):

¢ TRUE

e FALSE

3.2.4 GetLegendGraphic

Standard parameters for the GetLegendGraphic request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

Parametr Wymagany Opis

SERVICE Tak Name of the service (WMS)
REQUEST Tak Name of the request (GetLegendGraphic)
VERSION Nie Version of the service
LAYERS Tak Warstwy do wyswietlenia
STYLES Nie Styl warstw

SRS /CRS Nie Uktad wspétrzednych

BBOX Nie Zasieg mapy

WIDTH Nie Szeroko$¢ obrazu w pikselach
HEIGHT Nie Wysokos§¢ obrazu w pikselach
FORMAT Nie Legend format
TRANSPARENT Nie Przezroczyste tto

In addition to the standard ones, QGIS Server supports extra parameters to change the size of the legend elements or
the font properties for layer titles and item labels:
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Parametr Wymagany Opis

MAP Tak Plik projektu QGIS

SRCWIDTH Nie Map width

SRCHEIGHT Nie Map height

SHOWFEATURECOUNT Nie Add feature count of features

RULE Nie Rule symbol to render

RULELABEL Nie Item labels rendering

BOXSPACE Nie Space between legend frame and content (mm)
LAYERSPACE Nie Vertical space between layers (mm)
LAYERTITLESPACE Nie Vertical space between layer title and items (mm)
SYMBOLSPACE Nie Vertical space between symbol and items (mm)
ICONLABELSPACE Nie Horizontal space between symbol and label (mm)
SYMBOLWIDTH Nie Width of the symbol preview (mm)
SYMBOLHEIGHT Nie Height of the symbol preview (mm)
LAYERTITLE Nie Layer title rendering

LAYERFONTFAMILY Nie Layer font family

LAYERFONTBOLD Nie Layer title bold rendering

LAYERFONTSIZE Nie Layer title font size (pt)

LAYERFONTITALIC Nie Layer title italic rendering
LAYERFONTCOLOR Nie Layer title color

ITEMFONTFAMILY Nie Item font family

ITEMFONTBOLD Nie Item label bold rendering

ITEMFONTSIZE Nie Item label font size (pt)

ITEMFONTITALIC Nie Item label italic rendering

ITEMFONTCOLOR Nie Item label color

SHOWRULEDETAILS Nie Adds the rule text to JSON output
ADDLAYERGROUPS Nie Adds the layer groups to JSON output

BBOX

This parameter can be used to specify the geographical area for which the legend should be built (its format is
described /ere) but cannot be combined with the RULE parameter. The SRS/CRS parameter becomes mandatory
when using the BBOX parameter.

Przyktad URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries,airports
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

© Informacja

When the BBOX parameter is defined, the legend is referred to as a content based legend.
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WIDTH

This parameter is not used by default but becomes mandatory when the RULE parameter is set. In this case it allows
to specify the width in pixels of the output image.

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=getlegendgraphic
&LAYER=testlayer%20%C3%A8%C3%A9
&RULE=rulel

&WIDTH=30

&HETIGHT=30

